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Chapter 1. Version 7.6 Update Supplement 

Installing the New Version of Pulsonix 
It is recommended that you back-up all libraries, designs, technology files, profile files and report 
files before installing the latest version. Other than for any technical reason, this is good working 
practice, although you should already have a backup of this data! 

To install Pulsonix, insert the CD or double-click on the download executable and wait for a short 
time. The Autorun facility will start the installation procedure. Follow the on-screen commands from 
the install wizard. You can install Pulsonix 7.6 on top of your existing installation or along side if you 
prefer; however, you do not need to uninstall the old version first. 

Licensing 
Version 7.6 does not require a new license. If you are using a version of Pulsonix earlier than Version 
7.x, you will require a new license, this would have been supplied to you under the terms of your 
maintenance contract. 

For existing users upgrading from a previous version, it is recommended that you save the new 
license and overwrite the existing one. When requested during installation, simply click the No 
Change In Licensing check box on the licensing page of the installation wizard. The License 
Manager can be used to add new licenses and make changes to network licensing after the 
installation has been completed. 

Windows 7 Support 
As further confirmation, since the release of Pulsonix 6.1 (and for later versions) the release version 
of the Windows 7 operating system in both 32 and 64 bit variants is fully supported. No earlier 
Pulsonix versions can or will be supported. 

Windows 8 Support 
As of October 2012, Microsoft have released Windows 8 to the market. Pulsonix 7.5 and Pulsonix 7.6 
will both work under this operating system and can be fully supported under both 32 and 64 bit 
variants. To run V7.5 under Windows 8, please install the patch 4917 or later to ensure you are using 
a supported version. No earlier Pulsonix versions (pre-7.5 or earlier) can or will be supported. 

Beta or pre-release versions of Windows 8 cannot be supported. 
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Report Maker – New commands 
Various Report Maker improvements have been added to Version 7.6: 

List of Vias reports Highest and Lowest Track Layer 

 From within the List of Vias command, you can now report the Highest Track Layer and 
Lowest Track Layer attached to a via. 

 
A report output might look like this: 

CLK (505.460,516.890) 
Highest Via Layer: Top 
Lowest Via Layer: Inner 2 
------------------------- 
CLK (497.840,518.795) 
Highest Via Layer: Top 
Lowest Via Layer: Inner 2 
------------------------- 

 
This reports the same information as in Properties of a selected Via. 
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New command for reporting internally connected pins on a component 

The ability to report a list of all internally connected pins in a component has been added. This 
command inspects all internally connected pins that are defined in the Parts library using the + 
separation character. This is mainly used for PCB design reports as this pin information is not 
available in the interface. The Pin Name would be that defined in the Part but only shows one name. 

Note: this command does not report pins that are defined with a comma ‘,’ as externally connected. 

A small format example could look like this: 

 
A report output might look like this if you run the above script to generate a list of all the pins on a 
device to show those internally connected: 

U2 
1 1+2+5+6 
2 1+2+5+6 
3  
4  
5 1+2+5+6 
6 1+2+5+6 
 

If you want to refine the format file to only report pins on a device that are internally connected, the 
example below would accomplish this: 

 
There are two variables used; the first places the Internally Connected Pins into a variable named 
InternallyConnectedPins. The second extracts the first pin name found and puts it into another 
variable named firstInternalPin.  
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Within the firstInternalPin variable, the field separator + has been extracted from the 
InternallyConnectedPins list. 

 
The script then tests the Pin Name (using the If statement) to see if it matches the first internal pin 
name, if it does then it reports the Component Name, the Internally Connected Pins and the Net 
Name. 

When the script is run, the report looks like this, showing all the Internally Connected Pins on the 
device: 

U2 1+2+5+6 Sig09 
Changes to the Run Report command 

The Run Report command can now be placed anywhere in report script (previously it was only 
available as a top level command). 

Changes to Attribute command and new Is Valid and Validation fields 

A change to the Attribute command has been made. It now has a sub-fields drop down list instead of 
radio buttons. 

 
New Is Valid and Validation fields have also been added to this dialog. This allows a report to be 
written to show where component values are not valid – see Attribute Validation below. 
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Use Is Valid to check if an attribute value is valid, and use Validation to report the validation string 
for an attribute. 

 
This will report true or false in response to the Is Valid check. For example: 

U2 false 
U3 true 

New Rotation (Transformed) command 

A new Rotation (Transformed) command has been added. This differs from the Rotate command as 
it takes the Report Maker output rotation into consideration after using Transformation. 

So for example, if a Component has been rotated in the design by 90 degrees, once transformed by 90 
degrees in the report (because the whole design is transformed), using the new Rotation 
(Transformed) command, this will now report the Component as 180 degrees. 

 
Running the above script reports the original Component Rotation first, followed by the Rotation after 
Transformation: 

U2 90.0 180.0 
U3 0.0 90.0 

New command - Max Line Length & Fill With Spaces 

New Max Line Length command that forces each line to be truncated at the supplied length. 

Within this new command there is an optional Fill With Spaces parameter command to ‘pad’ out the 
line with spaces if the Max Line Length has not been reached. 

So for example, if a line us truncated to 80 characters using the new Max Line Length command 
(because the line length must be exactly but no more than 80 characters) but the line is only 70 
characters long, then the Fill With Spaces command will add another 10 spaces to the line. 
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New command - Scale 

A new Scale command for reporting the scale from documentation symbols and from Schematic 
gate symbols has been added. The format of the decimal number output can be defined by first using 
the Number Format command. 

 
The script above would report something like this: 

 U1 Scale 1.000 
 U2 Scale 2.000 
 U3 Scale 1.000 

Variable ‘Ask User For Value’ command now has a Default Value box 

The Variable Ask User For Value command now has a Default Value box. This is presented as the 
default answer when the question is asked. 

 
When run, the prompt is preset with a default response: 
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Number Format command now has a Show Trailing Zeros switch 

The Number Format command now has a Show Trailing Zeros switch. For example, scales 2.0 and 
1.23 are output (with precision 3) as 2.000 and 1.230 with it checked, and as 2 and 1.23 with it 
unchecked. 

 

Problem fix to Line Length command 

The Line Length command has been fixed and will now report the correct length of the current line.  

Note: This fix may affect some users who use this command in their scripts. 

Symbol Origin Size 
The ability to change the Symbol Origin Default Diameter in a PCB and Schematic design has been 
added so that you can set the size of Symbol Origins that are displayed on components. Changing the 
size in this dialog dynamically changes the size used in the design once the Apply or OK buttons 
have been pressed. 
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Changes to Grids 

Draw Grids Underneath Items 

There is a new Display option on the Options dialog to Draw Grids Underneath Items. This is 
useful when displaying grid lines and working with Construction Lines. 

 

Grid Crosses 

The ability to change a grid to use small ‘crosses’ instead of dots or lines has been added. These are 
easier to see than dots, but not as visually crowded as lines. The size of the cross is related to the size 
of the grid. 

Use the Crosses radio button on the Grids dialog to select this option. 

 
When used in the design, grid crosses look like this: 
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Move Cursor 10 Steps 
Four new commands have been added to move the cursor 10 grid steps. These can be assigned to one 
of the four arrow keys for example on the extended keyboard. 

In the Customise dialog, choose ’10 steps’ as the Filter to see the four choices; Cursor Down 10 
Steps, Cursor Up 10 Steps etc. 

 

View Actual Size 

View Actual Size 

From the View menu, select View Actual Size to view the design scale at 1:1 so that items on the 
screen are actual size. This is useful for taking a realistic perspective of your PCB designs. 

 

Calibrate Actual Screen Width 
The View Actual Size command on the View menu uses the Actual Screen Width to accurately 
display designs. By default, the screen width is calculated from system parameters and this value is 
shown in the Options dialog. If this value is not correct you can type in the screen width. 
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Clearing the Actual Screen Width: value will return it to the calculated system value.  

Note that this is the width of the display area, not the diagonal, as is often quoted by manufacturers; 
and it may include a distance outside the visible screen, if your display does not have the correct 
horizontal adjustment.  

You can choose the units used to display these values in this dialog.  

Calibrating your screen 

This is straight forward and needs only to be done once. 

 To calibrate your screen 

1. Within the design (Schematic or PCB), draw a shape to a known width across the screen. Draw 
the size so it will fit within the design area at a scale of 1:1. Make it 100mm for example (this 
size will fit most modern screens widths). 

2. From the View menu, select View Actual Size. 

3. Measure the shape width with a rule. Be careful not to scratch the screen. If the size is what you 
drew, then no calibration is required and you can finish. Some screens are correct, some aren’t. 

4. If it is not the correct size, carry on below: 

5. Now physically measure the width of the screen with a rule. Measure the illuminated portion of 
the screen. Make a note of this value. 

6. From the Tools menu, Options dialog, select Display. 

7. Under Calibrate Actual Screen Width, check the value of the System Parameters Suggest 
again your ‘measured’ value. If they are not the same, type your value into the Actual Screen 
Width entry. 

8. Press OK to close the Options dialog. 

9. In the design, from the View menu, select View Actual Size again. 

10. Physically measure the shape width in Pulsonix to verify it is now the shape width as drawn and 
shown in the Properties dialog. 



 Pulsonix Version 7.6 Update Notes   15 

Defaults for Specific Attributes 
You can now define defaults for specific Attributes. You would use this to create a specific set of 
parameters such as the Layer, Text Style or Text Alignment for each Attribute. 

 
You can also define default values for a specific Attribute Name. The dropdown list under Values 
for Specific Attribute is normally set to < Default >, which means that the above values are used for 
all Attributes which do not have specific values defined.  

 
To define values for a specific Attribute, select the name in the drop down list and check the 
Override box. You can now change the values to that required.  
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To remove specific values for an Attribute, select the name in the dropdown list, then uncheck the 
Override box.  

You can remove all Attribute specific values by pressing the Delete All Attribute Specific Values 
button. If this button is greyed out, you do not have any such values defined.  

Insert Attribute and Insert Attribute Position dialogs 

The Insert Attribute and Insert Attribute Position dialogs now show all the values you will get and 
you can choose to use the defaults, or change then to the required value. 
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Attribute Validation 
You can define a wildcard validation string along with an Attribute name on the Technology dialog. 
This is used to allow you to define specific values or contents for attributes up-front, and then for 
Pulsonix to check and verify them. 

For example, you could define the ROHS Compliant Attribute with a validation string of Yes. If 
this is then changed to No or another string, it will be flagged by the Design Rules Check option. 

 

Checking Validation strings 

Attribute Validation is checked by Design Rules Check, the Attribute Editor and Attribute 
Properties. If you attempt to change the value to one not matching the Validation characters, you are 
presented with a warning dialog: 

 
The Design Rules Check option has a new check box for checking validation attributes. 
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Extension of Wildcard format 
The wildcard format has been extended for this and any other use of wildcards. It now includes lists 
of alternative substrings (or cases) and a number of special formats - %i – integer string, %f – floating 
point number, %a – alphabetic string, %s – a string of alphabetic or integer characters – see below for 
full list. Other examples and full descriptions are available in the Online Help. 

For example, you could add a validation string of %{%iK|%iK%i%} If the company standard only 
allows a value of 4K7 or 4K but not 4.7K, then this validation string will allow both valid values to be 
entered and check. 

Wildcard characters supported:  

* - means match any number of characters (including none). 

? - means match exactly one character. 

| - means match either string (the string before or the string after). 

%d - means a single digit (e.g. 3). 

%i - means an integer of any length (e.g. 12345). 

%f - means a floating point number of any length (e.g. 123.456). 

%c - means a single alphabetic character of either case (e.g. b), %C will only match an upper 
case character. 

%a - means an alphabetic string of any length or case (e.g. abcdef), %A will only match upper 
case. 

%s - means a string of a mixture of alphabetic and integer characters of any length or case 
(e.g. 1a2b3c), %S will only match upper case. 

%u - means the name of a length unit - in long or short form (e.g. mm). 

%{string1|string2|string3%} - means match any of these strings as part of a longer wildcard 
string. You can add a blank alternative at the start of the list - %{|string2%} which matches 
blank or string2.  

Report Maker output of attribute Validation 

The Report Maker now has two new fields for an attribute, Is Valid and Validation. Use Is Valid to 
check if an attribute value is valid, and use Validation to report the validation string for an attribute. 
The Validation string is checked at run time for the report. 
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Changes to Component Variant Spreadsheet 
Using Paste to copy variant information from one component to another, it will now give you a 
warning to show you which components will have their Parts changed, this allows you to cancel the 
operation. A report can also be produced using the Report button if you require an audit trail of 
changes made. 

 
This warning can be switched off using the Component Variant Spreadsheet warning on the 
Warnings option tab of the Options dialog on the Setup menu. 

 

Changes to search criteria in Find dialog 
The Library searcher (Find option on Insert Component option) now has a Not Matches criteria 
option. Where Not Matches are specified, this takes any text that does not match, using wildcards if 
required 
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Scale Symbols 
You can now scale Documentation Symbols and Schematic Gate Symbols, as well as selections of 
Shapes and Text, using the new Scale command. Documentation Symbols in both Schematic and 
PCB editors can be scaled but PCB footprints cannot be scaled. 

So for example, you can scale a symbol and have two scales of the same symbol in the design. 

 
Styles are not scaled, so text remains the same height and lines remain the same width. Symbols 
retain their scale factor relative to the original symbol. The symbol scale can be seen or changed 
through the Properties dialog. 

 
The Scale command will scale the selection including symbols, by the given scale factor. 

Additional Cursor Type – 45-Crosshair 
You can now use a new cursor type of 45-Crosshair. This is like the full screen Crosshair but at 45 
degrees. This is available on the Options dialog under General. 
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Save Generated Block Symbol with Block Design (SCM) 
A block symbol can now be saved with the block design. This symbol will be used when the block is 
added to a design. Alternatively, the library of block symbols can still be used if required. 

You can edit the Symbol while editing the block by selecting Edit Block Design Symbol from the 
context menu with nothing selected. 

 

View Port Names in Block Symbol (SCM) 
A new Toggle Port/Pin Names command allows you to see the port names whilst editing a Block 
Symbol from a design. 
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Unfinished Schematic Connections (SCM) 
Schematic Connections are now highlighted as unfinished if they have one end on a bus and the 
other end dangling (even if they have a net name displayed). This means they are more easily 
identified as requiring action for completing the design. 

 

Measure Tool in Schematics (SCM) 
The Measure Tool is now available when editing Schematic Designs, Schematic Symbols and 
Schematic Doc Symbols. 

 

Changes to Construction Lines option (PCB) 

‘Along A Segment’ on circles and pad edges 

When adding construction lines, you can now use Along A Segment on circles and on the edges of 
pads (including user defined pads). Adding a segment on a circle will draw you a Circle construction 
Line. 
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Remove last segment when following construction lines 

When adding a track or shape and following construction lines, you can now use the Backspace key 
to remove the last segment added. This moves the cursor back to the end of the previous segment. 

 

Disengaging the Follow Construction Lines feature 

When adding a track or shape and following construction lines, you can uncheck the new Auto 
Switch Construction Lines option from the context menu to stop the shape from automatically 
switching to follow another construction line or circle. In this mode clicking on another construction 
line that intersects the one being followed will switch to the picked line. This is useful when you have 
a “nest” of lines and circles and want to follow just one path through it. 
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Snap to construction lines 

When moving a shape corner or track corner, you can now snap it to a construction line. This option 
is available on the context menu. 

 

Dimensions attached to construction lines 

Dimensions can now be attached to Construction Lines. 

 

Tolerances in Dimensions (PCB) 
When adding Dimensions you can now automatically add tolerance text to the end of a selected 
dimension.  

  
From within the Properties dialog of a Dimension, there is a new tab to define the Tolerance. 
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The tolerance text is a multi-line text item with its own text style, automatically attached to the end of 
the dimension text such that both text items are aligned through their vertical centres. The multi-line 
tolerance has been provided to create either unilateral or bilateral tolerances, or to be used for any 
other purpose you like. 

  
A Unilateral Dimension example A Bilateral Dimension example 

As well as being able to type the tolerance text, you can use the Insert ± button to insert the bilateral 
± character at the start of the text, and use the Load Default button to set the text to the default for 
that dimension type. 

Default Tolerances can be set up in the Design Settings dialog, Defaults and Dimensions. These can 
be defined for each of the three types of dimension, linear, radial and angular.  A default tolerance 
text style can also be set up. 

 

Changes to Radial Dimensions 
You can now add a Radial Dimension to show a pads drill hole dimension. Use the Next Snap Point 
command from the context menu when adding the Dimension to change from a round pad edge to its 
drill hole edge.  
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STEP Export – No Components (PCB) 
There is a new check box which disables the outputting of components to output the STEP file. Select 
the No Components check box If you only want the board shape. 

 

ODB++ Output - CAM350 Switch (PCB) 
In general, only one closed documentation shape is output to the comp_+_top and comp_+_bot plots. 
CAM350 allows more than one shape for the component shape and some of its processes require this. 
Check the All Closed Component DocShapes (CAM350) option if you require this. 

 
It should be noted that more than one viewer will reject the ODB++ design if there are more than one 
shape specified for each footprint definition. This should ONLY be checked if you are sure that your 
process can handle this. 

Change to Optimise All Nets (PCB) 
During normal use, Pulsonix now keeps track of which nets have been changed. This change means 
that when you use Optimise All Nets it will only optimise those that need it. For large nets, this 
means a significant speed up. There is no interface change for this. 
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Optimise After Edit (PCB) 
There is a new option (Optimise After Edit) on the Options dialog under Edit Track to force an 
optimise of the net being edited after the track edit has been completed. This affects Insert Track, 
Edit Track, Sketch Track, Complete as Track and the Delete Corner options. 

 

Display Pad Numbers in Pads (PCB) 
The ability to display pad numbers within the pads has been added to version 7.6. 

 
The display of pad names is controlled from the Colours dialog, Highlights 

 
From here, you can switch the Pad Name Text and Pad Name Background on and off and change 
the colour. Enabling the foreground but not the background will display the pad names with no 
highlighted background. 
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Save/Load Colours has also been updated to allow these settings and colours to be used. 

Options dialog 

Auto-Hide Zoom Level 

From the Options dialog and Display, you have a slider control for how far you can zoom in and out 
and the point that the text disappears. This allows you to zoom in close and for the text not to swamp 
the design. 

 
Setting the slider to the Low position avoids situations like this below where the pads can’t been seen 
under the pad names: 

 
Use the Reset button to reset the slider to its default position. 

Font Size for Pad Names in Pad 

The font style and size used to display the Pad Names in Pads can be adjusted from the Options 
dialog also to grow or shrink the font to your requirements. Some systems have been found to have 
very small display of fonts. This allows you to adjust the font bigger to make it visible. The font itself 
can be changed if you prefer a different style of font. 
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Options - New Track Length Limits page (PCB) 
The Track Length Limits selection has been moved from the Edit Track page onto its own options 
page. This is mainly used for the Interactive High Speed option. 

 

3+1 or 4+1 Resistor Bands for 3D Packages (PCB) 
You can now have 3+1 or 4+1 resistor bands when creating 3D packages. 

 
With the Stripe: box checked, Axial and Can components can be given a stripe on the component 
body. CAN shapes will get a stripe up the side of the body near to pin 1 or pin 2 depending on the pin 
1 checkbox. Axial components get a single stripe near one end or the other, except for Resistors and 
Inductors which will get the correct set of coloured stripes depending on the value of each 
component.  

Using the drop down list, you can choose to use 3 or 4 bands for the value (plus the tolerance band). 
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Reload Option - Keep local plane connect switch (PCB) 
On the Reload Part dialogs, you now have option (Keep local plane connect) to keep the local plane 
connect value defined on the pad in the design. (Previously this was tied in with the Keep attribute 
values option). 

 

Changes to Apply Layout Pattern (PCB) 
The Apply Layout Pattern feature now has an option to Apply To Components Only. When 
selected, this does not copy any tracks or additional design information with it, only Components. 
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Areas - Component Pad Keep In/Out (PCB) 
Within an Area properties, you can now make an area a Component Pad Keep In/Out area. This 
option does not apply to Free Pads, Die Pads or Mounting Holes. 

 

Select Track Path option (PCB) 
There is a new option available for PCB designs to select the tracks and vias in a track path. It is also 
available in the PCB Footprint editor. The Select Track Path option is available on the context menu 
when the following is selected:  

 
 When a track segment or via are selected, it selects all tracks and vias on the whole track path. 

 When multiple track segments are selected, it selects all tracks and vias on all selected track 
paths. 

 With 2 pads selected on the same net, this selects the tracks and vias in the minimum length path 
between the pads (if there is one). This path may pass through other pads, but they will not be 
selected. 

  

Two pads on the same net in the design are selected 
(using Ctrl-Select). 

The Select Track Path option is selected from the 
context menu. The shortest track path is 
highlighted. 
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If some tracks or vias in the path are not visible, a warning dialog will be displayed that allows the 
user to make them all visible. 

 
Properties has been changed to show the selected track segments length if you have tracks and other 
items selected in a single net. By using Select Track between 2 selected pads, in Properties you can 
see the minimum track length between the pads. 

 

Interactive High Speed (PCB) (Cost Option) 

Differential Pairs 
Two new check boxes have been added to the Options dialog and Interaction for Differentially 
Paired Tracks: 

 

Keep Correctly Paired 

When checked, the Keep correctly Paired option will not allow doubling-back and acute corners 
when adding or editing paired tracks. This avoids the tracks ending up curved or further apart than the 
required gap. Uncheck it to allow full movement (as in previous releases). It may be that allowing 
illegal pairing during an edit is the only way to get to the actual position required. 
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Without Keep correctly Paired checked. 
Tracks are allowed to be edited in illegally. 

With Keep correctly Paired checked. 
Tracks are restrained to not allow an 
illegal path. 

Show Centre-line 

When checked, the Show Centre-line option is used to show the line between the paired tracks that 
you are actually editing. The centre line is the grid position that the differential paired tracks are 
following. This visual indication helps ensure the tracks are in the correct position and shows the 
selected dynamic segments. 

 
The line is removed as soon as the edit, move or move corner is complete on the differential pairs. 

Serpentine Routing 
You can now add serpentine with mitred or curved corners. These can range from 180 degree curves 
to 90 degree corners. 

 
You can control the shape of the top of each loop. The mitre around each turn can be curved or 
straight, and the size of the mitre is defined by the Mitre Ratio, which is the proportion of the 90 
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degree corner taken up by the mitre. A value of 1.0 gives a complete 180 degree curve (or sawtooth if 
straight) around the top of the loop; a value of 0.0 gives a squared off top to the loop; values in 
between give a loop of two curves or 45 degree angled lines with a flat top between. The default is 
Curved with a Mitre Ratio of 1.0, which results in 180 degree curve around the loop. 

A Mitre Ratio of 0.585786 and straight mitre gives an octagonal shape around the loop (angled 
mitres and flat top with the same length). 

 
The Mitre Shape drop down list allows you to set the parameters for the most common shapes.  

 
180 Degree Curved – this would be a standard serpentine with curved corners. This presets the 
Mitre Ratio to 1.0 and produces 180 degree curved corners. If the Curved button is unchecked, it 
will produce a Sawtooth serpentine around the top of the loop. 

Octagonal – this produces a serpentine with the 45 degree mitre and flat ‘top’ lengths the same value. 

User Defined – if the value is set to a value not matching the above cases. 
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Eagle V6.3 Import 
The import of Eagle V6.3 designs and libraries is now supported. This feature was added to a later 
V7.5 issue with the addition of new ULP conversion files and new DLLs. These are now all included 
in the main V7.6 release. 

Allegro PCB Design Import (Cost Option) 
As part of the Advanced Import cost option, you can now import Cadence Allegro PCB designs. You 
can import Footprint libraries and Part libraries once the Parts have been saved to a PCB design, they 
cannot be imported directly. Please contact sales or your local Pulsonix distributor for more 
information. 

Library Changes 

New Libraries 

New libraries have been introduced for the Coilcraft LPS4018 series. This is new Parts and 
associated footprint. 

Changes to Existing Libraries 

Changes have been made to the Coilcraft 1008CS series Parts library to make values and Attribute 
names more consistent with other libraries. 

New Footprints 

New footprints have been added for the 0201 and 01005 surface mount footprints. 

New footprints have been added for the 148-QFN and 169-FBGA footprints. 

 


